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บทนํา 
ปจจุบัน เว็บไซตนับเปนเครื่องมือที่สําคัญสําหรับการสื่อสารทั้งภายในและภายนอกองคกร ดังนั้น 

กระบวนการออกแบบเว็บไซตจึงไดกลายมาเปนกระบวนการเพื่อการสื่อสาร มากกวากระบวนการทางดาน

เทคนิค (Geest 2001) การออกแบบเว็บไซตตองมีการศึกษา วิเคราะหและตัดสินใจในประเด็นตาง ๆ 

มากมาย ทั้งการเลือกใชสี การจัดการขอมูลและการออกแบบระบบนําทาง (navigation) การแบงสวนพื้นที่

การใชงานของหนาจอ การสรางคุณลักษณะพิเศษ (character) ใหกับเว็บไซต เพื่อใหสามารถสื่อสารกับ

กลุมเปาหมายที่จะเขามาเยี่ยมชมเว็บไซต และสามารถบรรลุวัตถุประสงคของการพัฒนาเว็บไซต               

บทความนี้ นําเสนอขั้นตอนการออกแบบ การวิเคราะหเนื้อหา วัตถุประสงค และขั้นตอนการพัฒนาเว็บไซต

สถาบันการศึกษา โดยใชประสบการณในการพัฒนาเว็บไซตคณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย 

ของผูเขียนเปนกรณีศึกษา  

 

การออกแบบเว็บไซต 
การออกแบบเว็บไซตที่ดี คือ การออกแบบใหเหมาะสมกับกลุมเปาหมายและลักษณะของเว็บไซต 

โดยคํานึงถึงความสะดวกในการใชงานของผูใชเปนหลัก เว็บไซตที่ออกแบบอยางมีประสิทธิภาพ ควรมี

ความเรียบงาย มีความสม่ําเสมอ สะทอนเอกลักษณและลักษณะขององคกรนั้นได มีเนื้อหาที่มีประโยชน           

มีระบบนําทางที่ใชงานงาย นาสนใจและดึงดูดใจ มีตราสัญลักษณ (logo) และชื่อเว็บไซตทุกหนา เขาถึง

ขอมูลโดยไมตองใชเมนูที่ซับซอน สามารถเขาถึงขอมูลที่ตองการไดทันทีโดยผูใชไมตองติดตั้งโปรแกรม

เพิ่มเติม หรือตองใชเบราวเซอรพิเศษอื่น ๆ  สามารถแสดงผลในหนาจอที่มีความละเอียดตาง ๆ กันได               

มีคุณภาพในการออกแบบ  ไมมีพื้นหลัง (background) ที่ลายตา เลือกสีพื้นหลังและสีชุดแบบอักษร (font)

อยางเหมาะสม ขนาดตัวอักษรพอเหมาะ รองรับเว็บไซตที่อาจมีขอมูลเพิ่มขึ้นเรื่อย ๆ จุดเชื่อมโยงตางๆ 

(links) สามารถเชื่อมโยงไปยังเว็บเพจที่มีอยูจริง  ปราศจากจุดเชื่อมโยงซึ่งไมทํางาน (broken link)  ใชเวลา

                                                 
* อาจารยประจําภาควิชาบรรณารักษศาสตร คณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย 
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ในการดาวนโหลดนอย แสดงผลเร็ว และมีการปรับปรุงเนื้อหาบนเว็บไซตอยางสม่ําเสมอ (ธวัชชัย ศรีสุเทพ 

2544: 14-23; Kentie 2002; ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ 2546: 26-43; Sklar 2003) 

 

กระบวนการพัฒนาเว็บไซต 
 กระบวนการในการพัฒนาเว็บไซต แบงออกไดเปน 5 ข้ันตอนที่สําคัญ ไดแก การสํารวจความ

ตองการ  การพิจารณาเนื้อหาของเว็บไซต  การกําหนดโครงสรางเว็บไซต  การออกแบบภาพ และการอนุวัต

และดําเนินการ โดยมีรายละเอียดดังนี้ (Geest 2001; ธวัชชัย ศรีสุเทพ 2544; ดวงพร เกี๋ยงคํา และ                 

วงศประชา จันทรสมวงศ 2546) 
 

ขั้นตอนที่ 1 : การสํารวจความตองการ 
 เร่ิมตนจากการศึกษาหนวยงานเจาของเว็บไซต เพื่อกําหนดเปาหมายของเว็บไซตที่ชัดเจน ศึกษา

ผูใช เพื่อใหสามารถระบุกลุมผูใช และความตองการของผูใช และศึกษาคูแขง เพื่อกําหนดกลยุทธใน               

การแขงขัน 
 

ขั้นตอนที่ 2 : การพิจารณาเนื้อหาของเว็บไซต 
 หลังจากการศึกษาขอมูลเบื้องตนและกําหนดวัตถุประสงคของเว็บไซตแลว จะสามารถกําหนด

แนวทางในการออกแบบเว็บไซต ขอบเขตเนื้อหาและการใชงาน เพื่อรวบรวมขอมูลและเนื้อหาของเว็บไซต

ตอไป 
 

ขั้นตอนที่ 3 : การกําหนดโครงสรางเวบ็ไซต 
 ในขั้นตอนนี้ จะนําขอมูลที่รวบรวมไดมาจัดระบบขอมูล โดยจัดทําแผนผังโครงสรางขอมูล และ

ออกแบบระบบนําทาง เพื่อออกแบบการใชขอมูลและเปนแนวทางในการคนดูเว็บที่จะพัฒนา 
 

ขั้นตอนที่ 4 : การออกแบบภาพ 
 ในขั้นตอนนี้ จะทําการออกแบบลักษณะหนาตาของเว็บเพจตามหลักการออกแบบเว็บที่ดี มีการ

จัดแบงพื้นที่ในหนาเว็บเพจ และมีรูปแบบโครงสรางขอมูลอยูในหนาเว็บที่ออกแบบนี้ ผลลัพธในขั้นตอนนี้

คือ เว็บเพจตนแบบที่จะใชพัฒนาเปนเว็บไซตตอไป 
 

ขั้นตอนที่ 5 : การอนวุัตและดําเนนิการ  
 ในขั้นตอนนี้ เปนการนําเว็บเพจที่ออกแบบมาสรางเปนเว็บไซตที่สมบูรณ รวมถึงการอัปโหลด 

เว็บไซตสูเครื่องแมขายเพื่อเผยแพรบนอินเทอรเน็ต และกําหนดแนวทางการบํารุงรักษาเว็บไซตทั้งเนื้อหา

และโครงสรางขอมูลใหทันสมัยอยูเสมอ 
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 สําหรับการออกแบบเว็บเพจตนแบบ มักจะใชโปรแกรมกราฟก เชน  Adobe Photoshop ในการ

ออกแบบ เนื่องจากสามารถเคลื่อนยายชิ้นสวนสวนตาง ๆ ของเว็บเพจ ทั้งภาพและสวนของพื้นที่ใชงาน             

แตละสวนไดโดยสะดวก อีกทั้งยังสามารถสรางภาพและตกแตงภาพประกอบเว็บเพจในหนาตนแบบไดเลย

โดยไมตองกังวลกับการจัดหนาในเอกสารดวยภาษาเอชทีเอ็มแอล ซึ่งตองอาศัยเทคนิคการจัดพื้นที่สวน

ตางๆดวยตารางที่ซับซอน สําหรับข้ันตอนในการพัฒนาเว็บเพจที่ออกแบบดวย Adobe Photoshop เปน 

เว็บเพจ มักจะใชโปรแกรมชวยสรางเว็บ เชน Macromedia Dreamweaver  Microsoft FrontPage  Allaire 

HomeSite เปนตน (ธวัชชัย ศรีสุเทพ 2544; ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ 2546; ฐิตารัตน 

รัชตะวรรณ 2547) 

 

การพัฒนาเว็บไซตคณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย 
 จากการที่ผูเขียนไดมีสวนในการออกแบบและพัฒนาเว็บไซตคณะอักษรศาสตร จุฬาลงกรณ

มหาวิทยาลัย จึงขอนําประสบการณจากการออกแบบและพัฒนาเว็บไซตดังกลาวมาเปนกรณีศึกษา 

ตลอดจนนํามาใชเปนตัวอยางประกอบการอธิบายตามทฤษฎี/หลักการออกแบบและพัฒนาเว็บไซตที่ได

นําเสนอไปในหัวขอที่ผานมา  โดยเริ่มตั้งแตการสํารวจความตองการ  การพิจารณาเนื้อหาของเว็บไซต             

การกําหนดโครงสรางเว็บไซต  การออกแบบภาพ และการอนุวัตและดําเนินการ จนเปนเว็บไซตที่สมบูรณ 
 

ขั้นตอนที่ 1 : การสํารวจความตองการ   
การสรางเว็บไซตสถาบันการศึกษาที่สามารถดึงดูดกลุมผูใชเปาหมายได จําเปนที่จะตองทําการ

วิเคราะหขอมูลเกี่ยวกับองคกรและผูใช  กําหนดวัตถุประสงคของเว็บไซต และศึกษาเว็บไซตของ

สถาบันการศึกษาอื่นที่มีลักษณะเดียวกัน  เพื่อทําใหเกิดความเขาใจองคกร และนําไปสูการออกแบบไดตรง

กับกลุมเปาหมาย และระบุคุณลักษณะของเว็บไซตได  
 

การวิเคราะหขอมูลเกี่ยวกับองคกรและผูใช 

ผูเขียนไดทําการวิเคราะหปณิธาน พันธกิจ และวัตถุประสงคของคณะอักษรศาสตรจากคูมือ

คุณภาพ   คณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย (2547: 10, 19) ซึ่งทําใหสามารถประมวลภาพรวม

ของคณะตามปณิธาน  พันธกิจและวัตถุประสงคที่วางไว ดังนี้ 

• ผลิตบัณฑิต ระดับปริญญาตรี-โท-เอก  กอใหเกิดขอมูลหลักสูตร เอกสารประกอบการสอน ทั้ง

หลักสูตรภาคปกติ และหลกัสูตรนานาชาต ิตลอดจนการสนับสนนุกิจกรรมตาง ๆ ของนิสิต 

• ผลิตผลงานวชิาการ กอใหเกิดตํารา/บทความ/งานวิจัย 

• บริการวิชาการ กอใหเกิดโครงการอบรมตาง ๆ ทัง้สําหรบับุคลากร และบุคคลภายนอก 

• กิจกรรมทาํนบุํารุงศิลปวัฒนธรรมไทย-สากล กอใหเกดิกิจกรรม โครงการตาง ๆ 
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จากการวิเคราะหปณิธาน พันธกิจ และวัตถุประสงคของคณะอักษรศาสตร ทําใหพอที่จะประเมิน

ลักษณะกลุมผูใชเปาหมายซึ่งคาดวาจะเปนผูใชเว็บไซตคณะอักษรศาสตรไดดังนี้ 

• นักเรียนชัน้มัธยมศึกษาตอนปลาย  

• นิสิตระดับปริญญาตรี ปริญญาโท ปริญญาเอก ทัง้นิสิตไทยและนิสิตตางชาติที่สนใจหลักสูตร

นานาชาต ิ

• นักวชิาการ นกัวิจัย บุคคลในวงวิชาการทัง้ในและตางประเทศ  

• บุคคลภายนอกที่สนใจการอบรมหลักสูตรทางดานอักษรศาสตร 
• บุคคลทั่วไป รวมถงึผูปกครอง 
 

เมื่อวิเคราะหกลุมผูใชเปาหมายไดแลว ตอไปจะเปนการกาํหนดวัตถุประสงคของเวบ็ไซต 

 

กําหนดวัตถปุระสงคของเวบ็ไซต 

จากกลุมผูใชเปาหมายขางตน ผูเขียนไดกําหนดวัตถปุระสงคของเวบ็ไซต ดังนี ้

เว็บไซตคณะอักษรศาสตร จุฬาฯ จัดทําขึ้นเพื่อใหบริการขอมูลเกี่ยวกับคณะ หลักสูตรที่เปดสอน และ

บริการวิชาการ กิจกรรมตาง ๆ ที่คณะจัด รวมถึงแสดงผลงานวิชาการที่จัดทําโดยคณาจารยในคณะ และเพื่อ

ชวยในการเผยแพรผลงานวิชาการ โดยใหบริการขอมูลแกนักเรียน นิสิต-นักศึกษา นักวิชาการ นักวิจัยและ

บุคคลในวงวิชาการ รวมถึงบุคคลภายนอก และผูปกครอง 

 

การศึกษาเว็บไซตสถาบันการศึกษาทีม่ีลักษณะเดียวกัน 

 การศึกษาเว็บไซตที่มีลักษณะการดําเนินงานใกลเคียงกัน จะชวยใหไดแนวคิดในการออกแบบ   

ชวยในการเลือกสี การจัดวางขอมูล และการแบงพื้นที่ใชงาน  ในเดือนพฤษภาคม 2548 ผูเขียนได

ทําการศึกษาเว็บไซตจากโฮมเพจและเว็บเพจของมหาวิทยาลัยชั้นนําในตางประเทศที่เปดสอนในหลักสูตร

อักษรศาสตรจํานวน 5 แหง แลวนํามาวิเคราะหเกี่ยวกับการออกแบบ การเลือกสี การจัดวางขอมูล และ 

การแบงพื้นที่ใชงาน  โดยมีรายละเอียดดังนี้ 
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Harvard University, Faculty of Arts and Science  (http://www.harvard.edu)  

 
โฮมเพจ       เว็บเพจ 

ใชโทนสีเขียว-แดง (สีตรงขามกัน*) มีโฮมเพจที่โดดเดน แตระบบนําทางมีการเปลี่ยนรูปแบบเมื่อเขาสูเมนู          

ใด ๆ ในโฮมเพจ ทําใหใชงานยาก 

 

Cornell University  (http://www.cornell.edu) 

 
โฮมเพจ          เว็บเพจ 

ใชโทนสีแดง – เทา (เขาไดกับทุกสี) มีโฮมเพจที่โดดเดน และระบบนําทางเหมือนเดิมในทุกๆหนา ทําให              

ใชงานงาย 

 

 

 

 

 

                                                 
* ดูทฤษฎีสีเพิ่มเติมในหัวขอ การพิจารณาเนื้อหาของเว็บไซต : การเลือกใชสี หนา 60 
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Monash University, Faculty of Arts  (http://www.arts.monash.edu.au) 

 
โฮมเพจ          เว็บเพจ 
 

ใชโทนสีแดง – ฟาเขม (สีตรงขามใกลเคยีง) เนนความเปนมนุษยศาสตรดวยการแสดงภาพคน มสีวนบริการ 
และสามารถคนหาขอมูลในเว็บไซตได  ระบบนําทางและสวนบรกิารเหมือนกันทุกหนา ใชงานงาย 
 

 

The University of British Columbia, Faculty of Arts  (http://www.arts.ubc.ca) 

 
โฮมเพจ          เว็บเพจ 
 

ใชโทนสีน้ําเงิน – น้ําตาลแดง (สีตรงขามใกลเคียง) เนนความเปนมนุษยศาสตรดวยการแสดงละคร และ

สถาปตยกรรม  แมวาในโฮมเพจและเว็บเพจจะยายตําแหนงของระบบนําทาง แตรูปแบบและวิธีใชคงเดิม 

เสริมสรางใหหนาแรกดูโดดเดน  
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he University of Ontario, Faculty of Arts and Humanities  (http://www.uwo.ca/arts) T

 
โฮมเพจ          เว็บเพจ 

ปะ 

ผูเขียนไดใชขอมูลจากการศึกษาเว็บไซตที่มีลักษณะเดียวกันกับคณะอักษรศาสตร จุฬาฯ เปนแนวทาง

นการก

ั้นตอนที่ 2 : การพิจารณาเนื้อหาของเว็บไซต 
ระสงคของเว็บไซต และศึกษาเว็บไซตจากตางประเทศ

ลว  ข้ัน

รูปแบบและเอกลักษณของเว็บไซต

 

ชโทนเขียว-มวง-แดง  เนนความเปนมนุษยศาสตรดวยภาพคนและศลิใ

 

 

ใ ําหนดรูปแบบของเว็บไซตตอไป 

 
ข
 เมื่อไดสํารวจขอมูลเบื้องตน กําหนดวัตถุป

แ ตอนตอไปจะเปนการพิจารณาถึงรูปแบบและเอกลักษณของเว็บไซต การเลือกใชสี การออกแบบ

การใชงาน และการกําหนดขอบเขตของเนื้อหาสําหรับเว็บไซตคณะอักษรศาสตร จุฬาฯ ซึ่งจะไดนําเสนอ

ตามลําดับตอไปนี้ 
 

การกําหนด  

ความตองการของกลุมผูใชเปาหมาย ดังนั้น ในการ

กําหนด

รี รูปแบบเว็บไซตนารัก สดใส 

ุขุม เปนทางการ 

  

การออกแบบเว็บไซตที่ดีควรออกแบบใหตรงกับ

แนวทางในการพัฒนาเว็บไซต จะตองกําหนดรูปแบบของเว็บไซตที่ตองการ กลุมเปาหมายของ

เว็บไซตอาจจําแนกตามระดับการศึกษา ความสนใจ อายุ เปนตน ทั้งนี้ปจจัยที่ใชประกอบการพิจารณา

จําแนกกลุมผูใชอาจสงผลตอรูปแบบของเว็บไซตได เชน 
 

ลุมผูใชเปาหมาย แบงตามระดับการศึกษา ก

o นักเรียนมัธยมปลาย – นิสิตปริญญาต

o นิสิตระดับปริญญาโท - เอก – นักวิจัย/วิชาการ รูปแบบเว็บไซตที่ส
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กลุมเปาหมาย แบงตามความสนใจ 

ูมิศาสตร วัฒนธรรม ภูมิปญญา 

วันตก  
 

ระ น ไรจึงจะสามารถใหเว็บไซตที่

ออกแบ

าง

o วรรณคดี ละคร  
o ประวัติศาสตร – ภ

o ศิลปะ หรือการสรางสรรคอารยธรรมตะวันออก - ตะ

ป เด็ ทาทายประเด็นหนึ่งในการออกแบบเว็บไซต คือ ทําอยาง

บ สามารถรองรับผูใชไดหลายกลุม (Geest 2001) จากการวิเคราะหขางตน จะเห็นไดวา              

คณะอักษรศาสตร มีกลุมผูใชเปาหมายที่หลากหลาย อย ไรก็ดี ไมวากลุมเปาหมายจะมีระดับการศึกษา

และอายุที่แตกตางกัน  หรือมีความสนใจขอบเขตเนื้อหาทางดานมนุษยศาสตรที่ แตกตางกัน                

กลุมเปาหมายหลักนาจะเปนผูที่มีความสนใจในสาขาดังกลาว ซึ่งสะทอนผานบุคลิกภาพที่มีความ

ละเอียดออน สุขุม ลุมลึก และมุงศึกษาความเจริญงอกงามในจิตใจมนุษย  ผูเขียนจึงเลือกที่จะสรางเว็บไซต

ที่มีความสุภาพออนโยน โดยผูเขียนเลือกใชดอกชงโคซึ่งเปนสัญลักษณหนึ่งของคณะ เพื่อสรางความ

ออนหวานและสรางเอกลักษณใหกับเว็บไซต 
 

ารเลือกใชสีก  

สีในเว็บไซต หากใชอยางสม่ําเสมอตลอดทั้งเว็บไซต จะสามารถใชเพื่อ “...สรางขอบเขตของ

เว็บไซต              

ส

ฉ

ที่สัมผัสไดดวยตา เมื่อผูใชคลิกเขาไปในแตละหนาก็ยังรูสึกไดวากําลังอยูในเว็บไซตเดียวกัน” 

(ธวัชชัย ศรีสุเทพ 2544: 206) การเลือกใช Theme สี จะชวยสรางใหเกิดความรูสึกแตกตางกันไป เชน 

Theme สีน้ําเงิน ใหความรูสึกสงบ เยือกเย็น มั่นคง Theme สีเทา ใหความรูสึกสุภาพและสรางสรรค 

Theme ีสม-เหลือง ใหความรูสึกสดใส การเลือกใชสี มีรูปแบบการใชชุดสีหลากหลาย เชน เลือกใชทุกสี 

เลือกใชเ พาะโทนสีรอน หรือโทนสีเย็น เลือกใชชุดสีตรงขามใกลเคียงกัน เลือกใชสีเดียวแตที่ระดับความ

เขม-สวางแตกตางกัน หรือเลือกใชสีเดียวในหลายเฉดสี เปนตน  (ธวัชชัย ศรีสุเทพ 2544: 183-205) 

 

 

 
เล ี หรือเฉพาะสีตรงข  งาย  ือกทุกส ามกัน      ใชเฉพาะสีโทนรอน/เย็น  วงจรสีอยาง

 

 

แดง 

อน

ฟาน้ําท
ฟา 

ม 

 

บาน

แดงเขม 

เขียวอ  

เขียวแก 

ะเล ฟาเข

น้ําเงิน

มวง 

เย็น 

 สม 

แดง 

เหลือง

 สม เหลือง 
มวง 

เขียว 

น้ําเงิน 
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              สีปกติ สวาง10% 25%  ทึบ10% 25% 

สีตรงขาม      ใชเฉพ  สีใดสีหนึ่งหลายเฉดสี 

ีของเว็บไซตมหาวิทยาลัยในตางประเทศที่เลือกศึกษา มีการใช Theme สีที่แตกตางกัน สําหรับสีที่

เลือกใช

   

ัน เนื่องจากตองการเนนใหใชงาน

งายมาก

   
ใกลเคียงกัน   าะสีใดสีหนึ่งที่ความสวาง-เขมตางกัน           ใชเฉพาะ

 

 

ส

ในเว็บไซตคณะอักษรศาสตร ผูเขียนเลือกสีขาว-เทา เนื่องจากสีเทาเปนสีสัญลักษณของคณะ           

และใหความรูสึกสุขุม มีปญญา ขณะที่สีขาว ใหความรูสึกสะอาด สําหรับพื้นหลังและชุดแบบอักษร            

ควรเลือกสีที่มีความเหมาะสมกัน (ธวัชชัย ศรีสุเทพ 2544; Kentie 2002)   ผูเขียนเลือกสีพื้นหลังสีขาวและ

ตัวอักษรสีเทาเขม เพื่อใหอานไดงาย และเขากับ Theme สีที่เลือกไว ทั้งนี้ เว็บไซตที่ดีควรหลีกเลี่ยงพื้นหลัง

ที่ลายตา (Kentie 2002) ผูเขียนจึงกําหนดพื้นหลังของเว็บไซตดวยสีพื้น 

นอกจากนี้ ผูเขียนตั้งใจจะใช Theme ในแตละเมนูเปนคนละสีก

กวาการสราง Theme สีที่เนนใหเกิดความรูสึก สําหรับโทนสี ผูเขียนเลือกใชสีที่มีความสวาง และ

เปนชุดสีในแตละเมนูดวยเหตุผลทางเทคนิค เพื่อใหโหลดสีและหนาเว็บไดรวดเร็ว  

 

   
Theme สีเดียวกันทัง้เว็บ   Theme สีแยกตามเมนู

 

ชมพูเขม

แดง 

เขียวแก 
ฟาเขม 

ชมพ

ชมพูออน

ู matt 

  

  ็นชมพูบานเย  

  ชมพูมวง ชมพูโอรส 
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การออกแบบการใชงาน 

ะแนวคิดในการออกแบบและพัฒนาเว็บไซต ผูเขียนไดนําหลักการมา

ประมวล

งาย และกาํหนดใหมีแผนที่นาํทาง 

2. นได 

ี

3. าจอคอมพวิเตอรที่มีความละเอียด (Resolution) ตางกัน เชน  

4. บ หรือวนิโดวแบบ Pop-up ที่เปดขึ้นมา

ดง

พ

5. ขนาด Default 

บ

   

6. 

 

 

สําหรับรายละเอียดเกี่ยวกับจํานวนเมน ูและเนื้อหา จะวเิคราะห จัดโครงสรางขอมูลของเว็บไซต 

และนําเ

จากการศึกษาทฤษฎีแล

และกําหนดแนวทางในการออกแบบการใชงานดังนี้  

1. ผูเขียนเลือกทีจ่ะใชสีแบงแยกตามเมนูเพื่อใหใชงานได
(Navigation Map) ในทุกหนา เพื่อใหผูใชทราบวากาํลังอยูในตําแหนงใดของเว็บไซต  

เว็บไซตคณะอักษรศาสตรทีจ่ะพัฒนา ควรมีจุดเชื่อมโยงไปยังโฮมเพจภาควิชา/หนวยงา

เนื่องจากผูใชเว็บสามารถใชจุดเชื่อมโยงดังกลาวเพื่อเขาสูเว็บไซตของภาควิชา/หนวยงานซึง่ม

หลายเว็บไดทนัทีเมื่อตองการ  

เว็บเพจที่สรางจะตองรองรับหน

800x600 จุดภาพ (pixel)  1024x768 จุดภาพ เปนตน 

หลีกเลี่ยงสิง่ทีผู่ใชอาจไมคาดหวัง เชน เสยีงเพลงประกอ

เมื่อโหลดหนาเว็บ เนื่องจากอาจทาํใหเกิดความรําคาญได (Kentie 2002) เว็บไซตคณะอักษร

ศาสตร จึงไมมีเสียงเพลง และไมแสดงขอความประชาสมัพันธใด ๆ ดวยวนิโดว Pop-up แตแส

เนื้อหาบนหนาเว็บเพจเลย หากจะแสดงขอมูลในลักษณะวินโดวแบบ Pop-up ผูเขียนจะแสดง

ขอความใหผูใชทราบ และเลอืกคลิกดูโดยสมัครใจเอง เชน คลิกดูภาพปกหนงัสือ หรือคลิกดูภา

กิจกรรมแบบขยายขนาด ซึง่การดูขอมูลเชนนีโ้ดยสวนใหญจะเปดเปนวนิโดวใหม  

ตัวอักษรควรมขีนาดพอเหมาะ (ธวชัชัย ศรีสุเทพ 2544; Kentie 2002) ผูเขียนเลือก

Font เปน Microsoft Sans Serif ขนาด 10 point ซึ่งเปนชุดแบบอักษรขนาดมาตรฐานที่ผูดูแลเว็บ

สวนใหญใช  บางคนอาจกาํหนดขนาดชุดแบบอักษรไวตายตัวเพื่อใหไมกระทบกับรูปแบบหนา

เอกสารที่จัดไว แตเพื่อใหรองรับกลุมเปาหมายที่อาจมีอายุที่แตกตางกัน ผูเขียนไดกําหนดชุดแบ

อักษรใหผูใชเว็บสามารถปรบัขนาดตัวอักษรเพิ่มเติมไดจากเมนู View > Text Size ของเบราวเซอร

ผูเขียนใหความสําคัญกับการใชงานที่เขาใจงาย   เมนู คาํสั่งการตาง ๆ  รวมถึงสวนตอประสานผูใช 

(Interface) จึงตองมีขอความที่ชัดเจนตามหลักการระบปุาย (Labeling) ดังนั้น หากมีสวนใดที่ให

ผูใชคลิกตอ หรือใหดาวนโหลดผูเขียนจะแสดงขอความบนหนาจอใหชัดเจน เชน กดเพื่อดูรูปขยาย

download .doc   download pdf   ดหูนาปก   ดูรายละเอียด เปนตน  

สนอในขั้นตอนตอไป 
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กําหนดขอบเขตของเนื้อหา 

ัตถุประสงคของเว็บไซต ผูเขียนไดรวบรวมขอมูลที่จะ

เผยแพร

จากการศึกษากลุมผูใชเปาหมายและว

บนเว็บไซต รวมถึงภาพประกอบขอมูล และภาพที่จะใชทําเว็บเพจ ซึ่งผูเขียนไดทําการถายรูปคณะ

อักษรศาสตรจุฬาฯ ในมุมที่ตองการเพิ่มเติม โดยจัดเก็บไวโฟลเดอร “ภาพถายคณะอักษรศาสตร” 

 

 
 

ั้นตอนที่ 3 : การกําหนดโครงสรางเวบ็ไซต  
รสารนิเทศในเว็บไซตคือ จะทําอยางไรที่จะชวยไมใหผูใช

ับสนก

ใ

ารของคณะ ประกอบดวย ขาวประชาสัมพันธ ประกาศสําหรับนิสิต 

ระดับที่ 2:  ขอมูลการบริหารงานคณะ ประกอบดวยเว็บเพจที่จําแนกตามฝายตาง ๆ ของคณะ 

ระดับที่ 3:  รายละเอียดปลีกยอยอื่น ๆ ภายใตงานบริหารคณะ เชน เว็บไซตของแตละภาควิชา  

 
ข
 ประเด็นสําคัญประการหนึ่งของการจัดกา

ส ับขอมูลจํานวนมากบนเว็บไซต (Geest 2001) ดังนั้น การจัดระบบใหกับโครงสรางเว็บไซตจึงมี

ความสําคัญตอการจัดการขอมูลบนเว็บ เพื่อใหผู ชสามารถเขาถึงขอมูลไดงาย ไมควรจัดโครงสรางขอมูลที่

มีระดับช้ัน (Hierarchy) จํานวนมาก การพัฒนาเว็บไซตที่ดี ควรมีการวางแผนการจัดวางขอมูลที่ชัดเจนโดย

ใชหลัก Flat Hierarchy (Sklar 2003) จากขอมูลที่วิเคราะหและรวบรวมไวในขั้นตอนที่ 1  ผูเขียนไดนํามา

จัดโครงสรางเว็บไซตจํานวน 3 ระดับ ดังนี้ 
 

 ระดับที่ 1:  การแจงขาวส 

การรับสมัครนิสิต/บุคลากร ผลงานวิชาการของคณาจารยในคณะ และแถบเมนูสําหรับคลิกไปยังสวนอื่น ๆ ของ

เว็บไซต 

  

ไดแก ฝายบริหาร ฝายวิชาการ ฝายวิรัชกิจ ฝายวิจัย และฝายกิจการนิสิต รวมถึงเว็บเพจแนะนําคณะใน

ภาพรวม 

  

ภาพถาย หนังสือในโครงการตําราคณะอักษรศาสตร ขอมูลวิจัย เปนตน 
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หนาแรก 

แนะนําคณะ บริหาร วิชาการ วิรัชกิจ วิจัย กิจการนิสิต 

จุดเชื่อมโยงไปยัง
เว็บไซตหนวยงาน 

นามานุกรม
บุคลากร 

แผนที่
เว็บไซต 

-ขอมูลเกี่ยวกับคณะ 
-ภาพถายคณะ 

-ผูบริหาร 
-นโยบาย 
-บุคลากร 

-ขอมูลหลักสูตร 
-กิจกรรมวิชาการ 

-ขอมูลความเปน 
  นานาชาติ 
-กิจกรรมวิรัชกิจ 

-ขอมูลทุนวิจัย 
-หนวยงานวิจัย 
-ผลงานทางวิชาการ
ที่จําหนาย 

-ขอมูลสําหรับนิสิต
-กิจกรรมสําหรับ 
   นิสิต 

-ขาวประชาสัมพันธ 
-ขาวสําหรับนิสิต 
-ขอมูลหลักสูตร 
-ผลงานวิชาการใหมที่ออกจําหนาย 

ระดับท่ี 3  หากมีเนื้อหามาก หรือมีภาพเปนจํานวนมาก จะแสดงเนื้อหาโดยยอ และแยก
รายละเอียดเปนแฟมขอมูลระดับที่ 3 เพื่อใหแสดงผลไดเร็ว  

ระดับท่ี 2 

 ระดับท่ี 1 

 
การแบงพืน้ทีแ่สดงขอมูลบนหนาจอและระบบนําทาง 

การออกแบบพื้นที่หนาจอ แนะนําใหทําในโปรแกรม Power Point กอน เพื่อรางและกําหนดพื้นที่

การใชงาน ซึ่งจะสามารถกําหนดการใชสีคราว ๆ ไดดวย โดยทั่วไป เว็บไซตจะประกอบดวยตราสัญลักษณ

ของเว็บไซต  ระบบนําทาง คือ เมนูหลัก เมนูยอย  และอาจมีสวนบริการซึ่งสวนมากใชการวางเมนูพิเศษ 

เชน แผนที่เว็บไซต การคนหาขอมูลภายในเว็บไซต (site search) หรือเมนูแบบกระโดด (Jump menu)     

สวนการแบงพื้นที่โดยมากจะตางกันที่รูปแบบของเมนูยอยซึ่งมีอยูดวยกัน 3 แบบ แตละแบบมีขอดี-

ขอจํากัดแตกตางกัน ดังนี้ 

แบบที่ 1  เมนูยอยที่สามารถเก็บไวโดยไมแสดงออกมาใหผูใชเห็น แตจะแสดงเมื่อนําเมาสไปวาง

บนปาย  แถบเมนูหลักจะมีเนื้อที่แสดงเนื้อหามาก แตหากตองการทราบเมนูยอยผูใชตองวางเมาสและคลิก

เพื่อหาขอมูลดวยตนเอง 

แบบที่ 2  เมนูยอยแสดงออกมาบนพื้นที่หนาจอเลย โดยปรากฏในแถบเมนูหลัก จะมีเนื้อที่แสดง

เนื้อหาไดมาก แตไมเหมาะกับเมนูหลักที่มีเมนูยอยจํานวนมากและไมคงที่  

แบบที่ 3  เมนูยอยแสดงออกมาบนพื้นที่หนาจอเลย โดยแสดงเฉพาะเนื้อหาที่สําคัญ แบบนี้จะมี

เนื้อที่ในการแสดงเนื้อหาลดลง แตแสดงโครงสรางขอมูลภายใตแตละเมนูหลักชัดเจนขึ้น โดยไมกระทบตอ

จํานวนเมนูยอยในแตละเมนูหลัก 
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    แบบที่ 1 เมนูยอยแสดงเมื่อวางเมาสบนปาย                                  แบบที่ 2  เมนูยอยอยูในแถบเมนูหลัก  

         

    แบบที่ 3 เมนูยอยเปนสวนหนึ่งภายใตเนื้อหาหลัก   

 

 

สําหรับเว็บไซตคณะอักษรศาสตร ผูเขียนเลือก

รูปแบบที่ 3 คือแสดงเมนูยอยบนหนาจอเลย เพื่อให

ชัดเจน และรองรับเมนูยอยในแตละเมนูหลัก ซึ่งอาจมี

จํานวนไมเทากัน  และยังเหมาะกับขอความในเมนูยอย ที่

อาจมีจํานวนคําแตกตางกัน ผูเขียนเลือกวางตําแหนงของ 

เมนูยอยที่ดานซายของหนาจอ เนื่องจากเปนตําแหนงที่

เว็บสวนใหญใชเปนที่อยูของจุดเชื่อมโยงตาง ๆ   Kentie (2002) ไดทําการศึกษาเว็บไซตชื่อดังของ

สหรัฐอเมริกาจํานวน 50 ไซต พบวา เว็บไซต 3 ใน 4 เลือกวางตําแหนงจุดเชื่อมโยงในบริเวณนี้ เว็บที่ผาน

การออกแบบตามมาตรฐาน จะทําใหผูใชคนดูไดงาย อีกทั้งยังทําใหรูสึกอุนใจและรูสึกคุนเคย แมวาอาจทํา

ใหเกิดความรูสึกเบื่อในบางครั้ง (ครัก 2545) 

 Menu1 >> sub-menu2 

 สําหรับตําแหนงของตราสัญลักษณ ผูเขียนออกแบบใหอยูในตําแหนงซายมือของหนาจอ เนื่องจาก

เปนแบบแผนมาตรฐานหนึ่งเชนกัน และเปนตําแหนงที่ผูใชเว็บจะดูในคร้ังแรกเมื่อเปดหนาจอตามหลัก

ทฤษฎีจากการศึกษาพฤติกรรมผูใชเว็บ 2 รูปแบบ คือ (Sklar 2003: 46-48)  

1) ทฤษฎีการกวาดสายตาแบบ Paper-based reading pattern เปนการกวาดสายตาอานในรูปแบบ

เดียวกับการอานหนังสือ คือกวาดสายตาจาก ซายไปขวา จากบนลงลาง สําหรับเว็บที่เปนลักษณะเว็บ

เนื้อหา เชนเว็บคณะอักษรศาสตรที่จะพัฒนา ผูใชเว็บจะกวาดตาเปนแนวซิกแซกดังภาพ 
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2) ทฤษฎีการกวาดสายตาแบบ Screen-based viewing pattern เปนการกวาดสายตาตามเข็มนาฬกิา 

ในเว็บที่แสดงหนาแรกเปนภาพทางเลือกในการเขาถึงขอมูลเชนเดียวกับการใชสัญรูป (icon)  

 

     

Logo 
                           Menu1 
 
 Menu 2                         Menu 3  

 
 Menu 4                          Menu 5 
 

Menu6
 

การกวาดสายตาแบบ Paper-based reading pattern    การกวาดสายตาแบบ Screen-based viewing pattern 

 

 

นอกจากนี้ ผูเขียนยังกําหนดใหมีแผนที่นําทางในทุกหนา เพื่อใหทราบตําแหนงในเว็บไซต และ         

ไมหลงทาง โดยกําหนดใหมีแผนที่เว็บไซตในสวนบริการ เพื่อคอยบริการขอมูลแกผูใชงาน  

จากการศึกษาเว็บไซตตางประเทศที่มีลักษณะเดียวกันกับเว็บไซตคณะอักษรศาสตร ผูเขียนเห็นวา

จุดเชื่อมโยงไปยังภาควิชา / หนวยงาน ที่ทําเปนเมนูแบบกระโดด ทําใหประหยัดเนื้อที่บนหนาเว็บเพจ       

ไดมาก จึงไดนํามาจัดใหอยูในสวนบริการของเว็บเพจทุกหนา เพื่อใหสามารถใชงานไดทุกเมื่อและบรรลุ            

ขอกําหนดการใชงาน    

แผนที่นําทางและขอมูลในสวนบริการ คือ แผนที่เว็บไซตสําหรับเชื่อมโยงไปยังภาควิชา/หนวยงาน 

และสารบบบุคลากร ถือเปนขอมูลสําคัญที่ควรจัดใหมีในเว็บเพจทุกหนา เปนไปตามกฎการออกแบบ

เว็บไซตที่ดีขอหนึ่งที่กําหนดใหบรรจุเนื้อหาที่มีคุณคาไวบนเว็บเพจทุกหนา (Kentie 2002: 2) 

 
ขั้นตอนที่ 4 : การออกแบบภาพ  
 จากการสํารวจขอมูลและวิเคราะหขอกําหนดเบื้องตน ผูเขียนไดนําขอกําหนดตาง ๆ มาทําการ

ออกแบบเว็บเพจดวยโปรแกรม Adobe Photoshop ซึ่งนอกจากจะชวยในการออกแบบแลว ภาพที่ไดจาก

โปรแกรมสามารถใชในการพัฒนาเว็บเพจ หรือจัดทําเปนแฟมขอมูลเอชทีเอ็มแอล ที่สามารถแสดงผลผาน

เว็บเบราวเซอรที่สมบูรณตอไป 
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 ข้ันตอนการออกแบบภาพสาํหรับเว็บเพจโดยใชโปรแกรม Adobe Photoshop มีรายละเอียดดังนี ้

1. เปดโปรแกรม Internet Explorer และปรับความละเอียดของจอเปนขนาด 800x600 จุดภาพ ซึ่ง

เปนหนาจอมาตรฐานสําหรับใชดูหนาเว็บ กดปุม Print Screen แลวสรางเอกสารใหม ขนาด 

800x600 จุดภาพ แลว Paste จะไดภาพขนาด 800x600 จุดภาพ เชนเดียวกับขนาดจอ  

2. ทําการแทรกภาพที่ตองการในหนาเอกสาร โดยใช Selection Tool เลือกสวนของภาพที่ตองการ 

แลวใช  Move Tool ลากภาพที่ตองการเขามา  

3. ใช Type Tool สรางขอความ และตราสัญลักษณตามตองการ 

 
 

4. สรางปุมโดยใช Shape Tool และ Text Tool อาจเชื่อม Text กับปุมโดยการเชื่อมโยง Layer ทัง้สอง 

แนะนาํใหสรางโฟลเดอร สําหรับเก็บ Layer ที่ใชประกอบเปนสวน ๆ เชน โฟลเดอรเมนู  โฟลเดอร

ตราสัญลักษณ เปนตน  
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ทั้งนี้ ผูเขียนไดเลือกสีในแตละเมนู โดยการเรียงลําดับสีตามวงจรสี และเลือกสีสําหรับแตละเมนู 

ตามความหมายและความรูสึกที่สีส่ือสารดังที่ธวัชชัย ศรีสุเทพ (2544: 183-205) ระบุไว เพื่อใหบรรลุ

วัตถุประสงคของการใชขอมูลในแตละเมนู ดังนี้ 

• สีชมพู เปนสีสัญลักษณของจุฬาลงกรณมหาวิทยาลัย ผูเขียนจงึเลือกเปนสีเมนูสําหรบั

โฮมเพจ และเมนูแนะนาํคณะ ซึ่งเปนสวนหนึง่ของจฬุาลงกรณมหาวทิยาลยั 

• สีมวง ใหความรูสึกสูงสง สรางสรรค มีปญญา จึงเลือกใหเปนสีของเมนู บริหาร 

• สีน้ําเงิน เปนสแีหงความมัน่คง ความฉลาดรอบรู  จึงเลอืกใหเปนสขีองเมนู วิชาการ 

• สีเขียว ใหความรูสึกยินด ีภักดี ความหวงั ความอุดมสมบรูณ จึงเลือกใหเปนสีของเมนู     

วิรัชกิจ 

• สีเหลือง ใหความรูสึกของการมองโลกในแงดี อบอุน มีธรรมะ จึงเลือกใหเปนสีของเมนู 

วิจัย 

• สีสม ใหความรูสึกกระตือรือรน เขมแข็ง อบอุน เปนมิตร จึงเลือกใหเปนสีของเมนู กจิการ

นิสิต 

5. สรางแถบประกาศ (Banner) โดยการใช Selection และ Fill สี อาจใชหลายสีซอนกันเปนหลาย 

Layer   
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6. สวนของสทีี่ตองการไลสี ใช Gradient Tool  

 
 

7. เติมขอความดวย Type Tool  

8. วางตาํแหนงของขอมูลตามตองการ  

 
 
ขั้นตอนที่ 5 : การอนวุัตและดําเนนิการ  
 เมื่อไดภาพเว็บเพจที่ตองการแลว ตอไปจะเปนการพัฒนาเว็บไซตโดยใชภาพที่ไดรับการออกแบบนี้ 

เปนหนาเว็บเพจ ซึ่งทําไดโดยการตัดภาพ และนําไปดําเนินการตอในโปรแกรมชวยสรางเว็บ ซึ่งผูเขียนใช

โปรแกรม Dreamweaver หลังจากที่ไดหนาเว็บเพจหนาแรกซึ่งเปนเว็บเพจตนแบบแลว ใหพัฒนาหนาเว็บ

หนารองตอไป ผูเขียนไดพัฒนาเว็บเพจหนารองและสรางเปนแผนแบบ (template) สําหรับใชเปนตนแบบ

ของเว็บเพจหนารอง ดังขั้นตอนการพัฒนาเว็บเพจจากไฟล Photoshop โดยสังเขปตอไปนี้ 
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1. เมื่อไดภาพเวบ็เพจที่ตองการแลว ทาํการตัดสวนภาพ โดยใช Crop Tool 

 
 

2. ลากเสน Guide เขามาจากไมบรรทัด  
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3. ใช Slice Tool ตัดภาพตามที่ทาํ Guide ไว  

 
 

 

4. เมื่อตัดภาพแลวคลิกขวาทีแ่ตละสวน เลอืก Edit Slice Options… แลวตั้งชื่อแตละสวน เพื่อนําไป

ตั้งชื่อใหกับแฟมขอมูลภาพที่จะตัดออกเปนแตละสวน  

 

1 

2 
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5. File > Save for Web คลิกที่แตละสวน แลวเลือกวาจะ Save เปนแฟมขอมูลจิฟ หรือเจเพ็ก 

สําหรับการตัดภาพในครั้งแรก แนะนําใหเลือกภาพเปนเจเพ็ก และเลือก Quality เปน 100 

เนื่องจากภาพที่ตัดแลว จะนํามาตัดภาพตออีกในภายหลัง 

 
 

6. กรณีที่ตัดภาพไว Photoshop ให Save เปนแฟมขอมูลเอชทีเอ็มแอลหนึ่งแฟม โดยแทรกภาพที่ตัด

ไวในตาราง จากกรณีนี้ จากภาพหนาเว็บเพจหนึ่งภาพ (แฟมขอมูล) เมื่อตัดภาพแลว Save for 

Web แลว จะไดแฟมขอมูลเอชทีเอ็มแอล ที่ประกอบดวยภาพ 4 ภาพ  ตั้งชื่อใหกับแฟมขอมูล

เหลานี้ แลวกดปุม Save ทั้งนี้ แนะนําให Save ไวในโฟลเดอรตางหาก โดยใหสรางโฟลเดอรใหม

สําหรับเก็บแฟมขอมูลทุกแฟม ทั้งแฟมขอมูลเอชทีเอ็มแอล และแฟมขอมูลภาพ ที่จะใชพัฒนาเปน

เว็บไซตที่สมบูรณตอไป 

 

 วารสารบรรณารักษศาสตร์ 25, 2 (2548) 76



 

7. เขาโปรแกรม Dreamweaver ทําการ Define Site ไปที่โฟลเดอรที่สรางไว จากนั้นดับเบิลคลิกที่

แฟมขอมูลที่ Save ไว Dreamweaver จะเปดแฟมขอมูลให ดังภาพ 

8. เมื่อคลิกที่ภาพ จะเห็นวาภาพจากโปรแกรม Photoshop เพียงภาพเดียวในตอนแรก ไดกลายเปน 4 

ภาพแทรกในตาราง 1 คอลัมน 4 แถว แตละภาพมีชื่อแฟมขอมูลตามที่ตั้งชื่อไวเมื่อ Edit Slice 

Option  โดยแฟมขอมูลภาพ จะอยูในโฟลเดอร images ซึ่งเปนโฟลเดอรที่สรางดวยโปรแกรม 

Photoshop เมื่อ Save for Web เปนแฟมขอมูลเอชทีเอ็มแอล 

 

ภาพที่ 1 
ภาพที่ 2 

ภาพที่ 3 

ภาพที่ 4 

โครงสรางตาราง 

 

9. กลับมาที่โปรแกรม Photoshop เปดแฟมขอมูลภาพที่ตัดไวในครั้งแรกในโฟลเดอร images แลวทํา

การตัดภาพเชนเดิม  
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10. จากภาพในขอ 9 จะเห็นวาจํานวนชองในแตละภาพ มีจํานวนไมเทากัน หรือมีความกวางไมเทากัน 

ซึ่งตารางในเว็บเพจ จะมีลักษณะเชนเดียวกันนี้ กลาวคือ ตารางเดียวกันในหนาเว็บ จะตองมีความ

กวางของเซลลในแตละคอลัมนเทากัน หากตองการใหเซลลในแตละแถวมีความกวางไมเทากัน 

จะตองแยกออกมาเปนคนละตารางกัน และไมสามารถทําไดเหมือนกับโปรแกรม Microsoft Word 

 

      

   Word สามารถทําได 
 เว็บไมสามารถทําได 

   

 

      

   

   

ตารางที่ 1 

ตารางที่ 2 

ตารางที่ 3 

เว็บตองแยกเปนหลายตาราง 

 

11. เมื่อ Save for Web แลว Save เปนแฟมขอมูลเอชทีเอ็มแอล อีกแฟมหนึง่ 
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12. เมื่อกลับมาที่ Dreamweaver จะเห็นวาไดแฟมขอมูลเอชทีเอ็มแอลแฟมใหม  ดับเบิลคลิกเพื่อเปด

แฟมนี้ จะไดแฟมขอมูลที่มีตาราง 1 ตาราง ขนาด 2 คอลัมน 1 แถว ตามที่ตัดภาพไว ในแตละเซลล

มีภาพที่ตัดไวแลว  

 
 

13. คลิกที่บริเวณตาราง จะปรากฏเสนสีเขียวซึ่งบอกโครงสรางของตาราง กดที่เสนรอบนอก เลือก 

Select Table แลว Edit > Copy 

 
 

14. เปดไฟลแรกทีท่ําไว คลิกภาพสวนที่ตองการแทนที่ดวยตารางซึง่มีภาพที่ตัดภาพใหม แลว Edit > 

Paste 

 
 

15. จะเหน็วาที่แฟมขอมูลแรก ในเซลลที่มีภาพที่ตัดในครั้งแรก จะมีตารางภาพที่ไดจากการตัดภาพครั้ง

ที่สอง มาแทนที่ภาพใหญนัน้ 
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16. ทําเชนนี้ กับภาพทีละสวน  

 
 

17. กําหนดสีพื้นหลังของเว็บเพจดวย Page Properties จากสวน Properties หรือจาก       

เมนู Modify > Page Properties 
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18. กดปุม F12 บนแผงแปนอกัขระเพื่อ Preview ลอง Preview ในหนาจอขนาด 800x600 จุดภาพ 

และขนาด 1024x768 จุดภาพ 

 
 

 

 

 

 

 

 

 

 

19. โครงสรางตารางจากภาพ Photoshop ที่สรางมานั้น เปนการกําหนดขนาดความกวางและความสูง

ดังนั้น จะตองปรับใหสวนขอมูลขยายตามขนาดหนาจอได ดังนี้ 
   Table width 777 px 

Cell (td) width 777 pixel height 100% 

Cell (td) width 777 pixel height xx pixel 

Cell (td) width 777 pixel height xx 

Cell (td) width 777 pixel height xx 

Table 

Height 

100% 

ตารางใหญ ใหกําหนดความกวาง 777  

        ความสูง 100% 

 

เซลลทั่วไปใหกําหนดขนาดความสูงไวเปน 

จุดภาพโดยดูจากขนาดภาพในเซลล 

 

 

เซลลที่ตองการใหขยายขนาดเมื่อขยาย

หนาจอ ใหกําหนดความสูงเปน 100% 
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20. ปรับขนาดตาราง ดงัขอกําหนดในขอ 19 ไดโดย กดที ่Tag Inspector ที่ Tag Table หลัง Tag 

Body แลวกาํหนดความสงูเปน 100 % 

 
 

21. ที่เซลลแตละเซลลอาจคลิกที่ใด ๆ กอน แลว Select Table จากนัน้ไปที่ Tag Inspector จะเหน็วา 

Select Tag Table ไวอยู ใหไปเลือก Tag td (เซลล) กําหนดขนาดความสูงของ td ใหเทากับขนาด 

ความสงูของตารางในเซลล 

 

 1 Select Table 

2  ดูขนาด ความสูง 

3  คลิก <td> 

4  เติมขนาดใหเทากัน 
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22. ที่ตารางในเซลลสวนที่ตองการใหขยายขนาดเมื่อหนาจอใหญข้ึน ใหปรับขนาดตารางเปน 100 % 

 
 

23. กําหนดใหเซลล (td) ของตารางใหญทุกเซลลในแนวตัง้เปน Top ทุกเซลลเพื่อใหขอมลูอยูชิดขอบ

บนของเซลล 
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24. กดปุม F12 เพือ่ Preview   

 
 

25. เมื่อไดผลเปนที่นาพอใจแลว พยายามตัดภาพในสวนเนือ้หา ใหเหลือภาพขนาดเล็กที่สุด ใชภาพ

นอยที่สุด โดยนําภาพมาตัดอีกเชนเดิมใน Photoshop เพื่อสรางโครงสรางตารางสาํหรับใสเนื้อหา

ของเว็บไซตดวย  
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26. จะเห็นวาผูเขียนตัดภาพออกจนหมด เหลือไวแตสวนภาพดอกไม ซึ่งใชเปนเหมือนจุดนํา (Bullet) 

หนาหัวขอ สวนชื่อหัวขอนั้น ผูเขียนใชขอความพิมพเขาไปใหม ทั้งนี้ นอกจากจะเปนการลดการใช

ภาพประกอบเว็บเพจอันจะมีผลตอเวลาที่ใชในการโหลดหนานั้น ๆ แลว ยังทําใหสามารถเพิ่มเติม 

ปรับขอความไดในทันทีใน Dreamweaver โดยมิตองกลับไปแกไขภาพหัวขอในโปรแกรม 

Photoshop  

 

27. สรางเมนูแบบกระโดด ดวย From > Jump menu 

พิมพขอความเขาไปใหมใน 
Dreamweaver 

ภาพที่ใช 

Jump 

 
 

28. ที่ปุมภาพ แทรกจุดเชื่อมโยงโดยตั้งชื่อแฟมขอมูลที่จะใชโยงไปรอไว โดยจะสรางแฟมขอมูลเหลานี้

เปนหนารองตอไป 

29. ทําการ Save  จะไดหนาแรกที่สมบูรณ ข้ันตอนตอไป คือสรางหนารอง โดยทั่วไปแลว หนาแรก 

มักจะมีความโดดเดนกวาหนารอง แตระบบนําทางที่ดีและใชงานงาย ควรมีตําแหนงในการนําทาง 

(ปุม เมนู ตางๆ) ที่อยูในตําแหนงเดียวกันทุกหนา ดังนั้น ใหทําการ Save As หนาแรกนี้ เปน

แฟมขอมูลใหมสําหรับใชเปนตนแบบสรางหนารองตอ ๆ ไป 

30. ในแฟมขอมูลใหม ทาํการตกแตง เอาแถบประกาศออก และจัดหนาสําหรับใสขอมลูในหนารอง 

แลวใชปุม Make Template สําหรับสรางแผนแบบ ใหตั้งชื่อแฟมขอมูลวา template แลว Save  
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31. สัง เกตดูชื่ อแฟมขอมูล  จะเปนการทํางานที่แฟมขอมูลชื่อ  template ซึ่ ง เปนแฟมขอมูล

นามสกุล .dwt (Dreamweaver Template) สําหรับแฟมขอมูลเอชทีเอ็มแอลของหนารองที่สรางไว 

สามารถเลือกเก็บไวทําแผนแบบอื่น ๆ หรือลบทิ้งก็ได 

การใชแผนแบบจะทําใหปรับปรุงเว็บไซตไดงาย เนื่องจากเว็บเพจหลายหนามีสวนนําทางที่

เหมือนกัน มีเพียงสวนเนื้อหาในแตละหนาเทานั้นที่แตกตางกัน ดังนั้น หากตองการปรับสวนที่

เหมือนกัน เชน เปลี่ยนภาพ เปลี่ยนชื่อไฟล ปรับเมนูยอย แลวตองแกไขทุกไฟลจึงเปนวิธีการที่ไม

เหมาะสม  ในทางกลับกันหากใชวิธีการโดยใชแผนแบบแลว การแกไขที่แฟมขอมูล template ทํา

เพียงแฟมเดียว เมื่อแกไขและ Save โปรแกรม Dreamweaver จะไปปรับแฟมขอมูลที่ใชแผนแบบ 

นั้น ๆ ใหโดยอัตโนมัติเอง 

 

 

 

 

 

 

 

 

 

 

 
 

 สวนที่มีเหมือนกันในทุกหนา (ทุกแฟมขอมูล) 
 สวนที่มีเหมือนกันในเมนูเดียวกัน 
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32. ใหทําการกําหนดสวนที่เปนพื้นที่ที่สามารถแกไขขอมูลได (สวนขอมูลที่ตางกันในแตละหนา) โดย

เนนขอมูลใหเดน (highlighting) แลวใชปุม Editable Region เมื่อสรางแผนแบบแรกแลว Save 

จากนั้น Save As แฟมขอมูล .dwt ใหมสําหรับสรางแผนแบบของเมนูใหม แลวปรับขอมูลและสีให

เปนของเมนูใหม ใหสรางแผนแบบของแตละเมนู 

 
 

33. ในการสรางไฟลจากแผนแบบ ให File > New > เลือก Tab Templates > เลือก Site และ Template 

ที่ตองการ 
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34. เมื่อไดเอกสารเอ็ชทีเอ็มแอลเปลาแลว เติมขอความ ภาพ และขอมูลอ่ืน ๆ ที่ตองการ แลว Save 

เปนแฟมขอมูลเอชทีเอ็มแอล เมื่อไดหนาเอชทีเอ็มแอลครบตามจํานวนเมนูยอยแลว ใหกลับมาที่

แฟมขอมูลแผนแบบของเมนูนั้น แลวเชื่อมตอจุดเชื่อมโยงที่เมนูยอย กับแฟมขอมูลเอชทีเอ็มแอลที่

ตองการโยงไป เมื่อทําการแกไขใด ๆ ใน template แลว Save โปรแกรมจะถามวา ตองการปรบัสวน

ที่ใชรวมกันในแฟมขอมูลที่ใชแผนแบบนี้หรือไม ใหเลือก Update 

 
 

35. กรณีที่หนาใดมีโครงสรางขอมูลที่ซ้ํา ๆ กนั ใหสรางแผนแบบที่ม ีRepeating Region  
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36. เมื่อ File > New แลวเลือกแผนแบบที่มี Repeating Region จะสามารถเพิ่ม ลบ รายการ และ           

Re-Order รายการได (เพิ่มโดยกดปุม + ลบ กดปุม – และยายรายการโดยกดปุม   ) 

 
 

37. เมื่อเชื่อมตอจุดเชื่อมโยงใหกับทุกไฟลในเว็บไซตแลว ใหทําการตรวจสอบจุดเชื่อมโยงกอนจะ

เผยแพรเว็บไซตโดยใชเมนู     Site > Check Link Site Wide โปรแกรมจะทําการตรวจสอบ

จุดเชื่อมโยงที่ปลายทางที่ยังไมมีการระบุแฟมขอมูลข้ึนมาให เพื่อคนดูชื่อแฟมที่ถูกตองใหมอีกครั้ง 
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ตัวอยางการนําเทคนิคการออกแบบเว็บเพจใหแสดงผลไดเร็วมาใชงาน 
ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ (2546) ไดสรุปเทคนิคการออกแบบเว็บเพจให               

แสดงผลไดเร็วซึ่งสามารถทําไดหลายวิธี ดังนี้ 

• ลดขนาดของแฟมขอมูลเอชทีเอ็มแอล โดยตัดคําสั่ง หรือปายระบุ (tag) ที่ไมจาํเปนออกไป 

• ใชตัวอักษร และจุดเชื่อมโยงดวยภาษาเอชทีเอ็มแอล 

• ใชกราฟกใหถกูประเภท 

• ตัดแบงภาพทีม่ีขนาดใหญใหเปนภาพชิน้เล็ก ๆ 

• นํากราฟกกลบัมาใชใหมในหนาอื่น ๆ 

• กําหนดคาความกวางและความสงูของกราฟก 

• กําหนดคา Lowsrc และ Alt ของกราฟก 

• ใช Style Sheet ในการจัดรูปแบบ 

 

เว็บเพจที่ดี ควรแสดงผลหนาเว็บเพจไดรวดเร็ว ใชเวลาในการดาวนโหลดนอย (ธวัชชัย ศรีสุเทพ 

2544; ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ 2546) ผูเขียนไดนําเทคนิคการออกแบบเว็บเพจให

แสดงผลไดเร็วขางตน มาใชในการพัฒนาเว็บไซตคณะอักษรศาสตร ดังนี้ 

1. การลดขนาดของแฟมขอมูลเอชทีเอ็มแอล ผูเขียนไดใชภาพประกอบใหนอยที่สุด จากการตัดภาพที่

ออกแบบดวยโปรแกรม Photoshop และพัฒนาเปนหนาเว็บเพจ ซึ่งประกอบดวยภาพขนาดใหญ 

ผูเขียนไดตัดภาพเปนชิ้นเล็กลงไปอีกหลายครั้ง และพยายามแทนที่ภาพดวยสีพื้นในตาราง               

ชื่อหัวขอในหนาแรก ผูเขียนไดแทนที่ดวยขอความ   

2. นอกจากปุมเมนูแลว จุดเชือ่มโยงอืน่ ๆ จะเปน

ขอความ ทั้งชือ่หัวขอในหนาแรก และขอความ

ของเมนูรองบนเว็บเพจที่ปรากฏในเมนูอ่ืนๆ 

3. ภาพกราฟกทีใ่ช สรางจากการ Save for Web 

ในโปรแกรม Photoshop จะเปนภาพสําหรับเว็บ 

ซึ่งจะมีขนาดเล็กกวาภาพที ่Save As เปน

แฟมขอมูลจิฟ หรือเจเพ็ก ทั่วไป 

4. การใชภาพกราฟกซ้าํ เชนภาพปุมเมน ูและภาพจุดนําของหวัขอในหนาแรก 

5. ในการแทรกภาพดวยโปรแกรม Dreamweaver โปรแกรมจะกําหนดขนาดความกวาง และความสงู

ของภาพใหโดยอัตโนมัติอยูแลว นอกจากนี้ ผูเขียนไดกาํหนด Alt text ใหกับภาพปุมเมนูอีกดวย 
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6. เว็บเพจที่จะโหลดไดเร็ว ควรมีรหัสคําสั่งใหนอยที่สุด หากตองจัดรูปแบบสีสวนใด เชน หัวขอ สีชุด

แบบอักษร สีจุดเชื่อมโยง ใหใช Style Sheet โดยเปนแฟมขอมูล Style Sheet ที่ทุกแฟม เรียกใชได

แบบเชื่อมโยง ซึ่งนอกจากจะใชรหัสคําสั่งจํานวนนอยในแตละหนาแลว ยังแกไขไดงายเนื่องจาก

แกไขจากแฟมขอมูลแฟมเดียว และทําใหเกิดความสม่ําเสมอเนื่องจากเว็บไซตใชชุดแบบอักษร

เดียวกันตลอดทั้งไซต 

 

นอกจากเทคนิคขางตนแลว ผูเขียนไดสอดแทรกเทคนิคอื่น ๆ ที่ชวยใหผูใชสามารถโหลดเว็บเพจ             

ไดเร็วอีกดวย เชน 

7. สีพื้นหลังในเซลลของตาราง และ สีชุดแบบอักษร

ที่ตองใชเบราวเซอรในการประมวลผล ควรใชสี

เว็บ เชน #33FFCC, #FFFFFF, #FF00CC 

เนื่องจากเปนสีที่โหลดไดเร็วกวาสีที่ไมใชสีเว็บ 

เชน #6D3C16, #CDFC36 

 

 

8. หากในหนาเว็บเพจนั้น ๆ มีภาพจํานวนมาก ใหแยกหนาที่มีรูปออกมาเปนแฟมขอมูลตางหาก 

เพื่อใหปริมาณภาพในหนานั้น มีจํานวนนอยลงและใชเวลาโหลดภาพนอย 

  
 

แยกไฟลออกมา เพื่อลดจํานวนภาพในหนานั้นๆ 
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9. หากตองใชภาพในขนาดตาง ๆ กนั ควรใชเปน

แฟมขอมูลแยกตางหาก ไมควรใหเว็บเบราวเซอร

ยอ หรือขยายภาพโดยกาํหนดขนาดความกวาง

ความสงูของภาพใหมใน Dreamweaver เพราะ

จะตองใชเวลาในการลด-ขยายขนาดภาพ และ

กรณีที่ภาพมีขนาดเล็กแตตองการขยายภาพ 

ภาพจะแตกได คุณภาพความชัดของภาพจะ

ลดลง                                                คลิกแลววินโดวใหมจะเปดขึ้นเพื่อแสดงภาพอีกภาพหนึ่ง  
                                                                                                                  ซึ่งมาจากแฟมขอมูลภาพอื่น 

 

สรุป 
 ผูเขียนไดนําเสนอการออกแบบและพัฒนาเว็บไซตตามหลักการออกแบบเว็บไซตที่มีประสิทธิภาพ 

โดยนําเว็บไซตของคณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัยเปนกรณีศึกษา การออกแบบและพัฒนา

เว็บไซต มิใชเปนเพียงการลงมือพัฒนาเว็บไซต แตตองอาศัยองคประกอบหลายประการ เพื่อใหไดเว็บไซต 

ที่ดีทั้งการออกแบบและการใชงาน ผสมผสานกับเทคนิคหลายประการ รวมถึงการจัดโครงสรางขอมูลเพือ่ให

สามารถโหลดหนาไดเร็ว การพัฒนาเว็บไซตสวนมากจะเริ่มจากการออกแบบหนาเว็บเพจดวยโปรแกรม 

Photoshop และนํามาพัฒนาเปนหนาเว็บเพจดวยโปรแกรมชวยสรางเว็บ โดยการตัดภาพที่ดีไซนไวมาเปน

หนาเว็บเพจ อยางไรก็ดี โปรแกรม Photoshop ยังใชชวยในการแตงภาพ และสรางปุม หรือภาพสําหรับ

ตกแตงเว็บเพจเพิ่มเติมดวย เว็บไซตที่ดี ควรมีเนื้อหาที่ทันสมัยและตองปรับปรุงขอมูลอยูเสมอ เว็บไซตที่

ออกแบบจึงควรตองรองรับเนื้อหาของเว็บไซตที่จะเพิ่มมากขึ้น และรองรับการปรับปรุงเว็บไซต  ในการ

พัฒนาเว็บไซตนี้ ผูเขียนใชแผนแบบ ซึ่งทําใหการปรับปรุงเว็บไซตใหทันสมัยทําไดงาย ซึ่งนับต้ังแตวันที่

ผูเขียนไดอัปโหลดเว็บไซตเพื่อเผยแพรสูอินเทอรเนต ที่ http://www.arts.chula.ac.th เมื่อวันที่                 

20 พฤษภาคม 2548 ไดมีการปรับเปลี่ยนขอมูลในเมนูยอยและสวนบริการหลายครั้ง เว็บไซตคณะ               

อักษรศาสตรที่พัฒนาสําเร็จและเผยแพร ประกอบดวยแฟมขอมูลเอชทีเอ็มแอล หรือเว็บเพจแตละหนา ทั้ง

เว็บไซตเปนจํานวน 130 แฟม  แฟมแผนแบบสําหรับแตละเมนู ทั้งแผนแบบปกติและแบบ Repeating 

Region รวม 13 แฟม ภาพที่ใชเปนเมนูและตราสัญลักษณ รวม 14 ภาพ และภาพประกอบขอมูลในเวบ็ไซต 

ที่ใช Photoshop ปรับแตง เชน ภาพกิจกรรม ภาพปกหนังสือ เปนจํานวน 780 ภาพ ใชเวลาในการพัฒนา

เว็บไซตประมาณ 200 ชั่วโมง  นับต้ังแตการศึกษาวิเคราะหขอมูลเพื่อกําหนดกลุมเปาหมายและการ

ออกแบบ การรวบรวมขอมูล  การถายภาพ จนถึงการพัฒนาเปนเว็บไซตที่มีเนื้อหาสมบูรณ ผูเขียนหวังเปน

อยางยิ่งวาบทความนี้ จะเสริมสรางเทคนิคและแนวคิดในการพัฒนาเว็บไซตที่ดีใหแกผูอานไดไมมากก็นอย 
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